
1315105051-enclosu
re.pdf

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

TUGAS AKHIR – SS141501 

 

 

PEMBENTUKAN ZONA MUSIM KABUPATEN 

NGAWI DENGAN METODE SKATER  

(SPATIAL ‘K’LUSTER ANALYSIS  

BY TREE EDGE REMOVAL) 
 

 

PARTINI NINGSIH 

NRP 1315 105 051 

 

 

Dosen Pembimbing 

Dr. Sutikno, M.Si 

 

 

 

 

 

PROGRAM STUDI SARJANA 

DEPARTEMEN STATISTIKA 

FAKULTAS MATEMATIKA DAN ILMU PENGETAHUAN ALAM 

INSTITUT TEKNOLOGI SEPULUH NOPEMBER 

SURABAYA 2017 



 

 
 
 
 
 
 
 
 
 
 
 
 
 

TUGAS AKHIR – SS141501 
 
 

PEMBENTUKAN ZONA MUSIM KABUPATEN 

NGAWI DENGAN METODE SKATER  

(SPATIAL ‘K’LUSTER ANALYSIS  

BY TREE EDGE REMOVAL) 
 

 

PARTINI NINGSIH 

NRP 1315 105 051 

 

 

Dosen Pembimbing 

Dr. Sutikno, M.Si 
 
 
 
 
 

PROGRAM STUDI SARJANA 

DEPARTEMEN STATISTIKA 

FAKULTAS MATEMATIKA DAN ILMU PENGETAHUAN ALAM 

INSTITUT TEKNOLOGI SEPULUH NOPEMBER 

SURABAYA  2017 



 

 
 
 
 
 
 
 
 
 
 
 
 
 

FINAL PROJECT – SS141501 
 
 

FORMING SEASON ZONES OF NGAWI  

WITH SKATER METHOD 

(SPATIAL ‘K’LUSTER ANALYSIS  

BY TREE EDGE REMOVAL) 
 

 

PARTINI NINGSIH 

NRP 1315 105 051 

 

 

Supervisor 

Dr. Sutikno, M.Si 
 
 
 
 
 

UNDERGRADUATE PROGRAM  

DEPARTMENT OF STATISTICS 

FACULTY OF MATHEMATICS AND NATURAL SCIENCES 

INSTITUT TEKNOLOGI SEPULUH NOPEMBER 

SURABAYA  2017 





v 

 

PEMBENTUKAN ZONA MUSIM  

KABUPATEN NGAWI DENGAN METODE SKATER  

(SPATIAL ‘K’LUSTER ANALYSIS BY TREE EDGE REMOVAL) 
 

Nama Mahasiswa  : Partini Ningsih 

NRP  : 1315 105 051 

Departemen  : Statistika  

Dosen Pembimbing : Dr. Sutikno, M.Si. 
 

 

Abstrak 
Pengelompokan pola curah hujan dengan membuat Zona Musim 

(ZOM) telah dilakukan oleh BMKG. Metode yang sering digunakan 

dalam pembentukan ZOM adalah analisis kelompok yang tidak 

memperhatikan aspek lokasi objek penelitiannya padahal unit observasi 

berupa lokasi stasiun hujan, sehingga aspek spasial seharusnya menjadi 

hal yang dipertimbangkan dalam pembentukan ZOM. Salah satu metode 

pengelompokan spasial adalah analisis SKATER.  

Data yang digunakan dalam penelitian ini merupakan data 

sekunder, bersumber dari BMKG Stasiun Klimatologi Klas II 

Karangploso Malang. Variabel yang digunakan adalah curah hujan 

bulanan di Kabupaten Ngawi dari tahun 1990-2015. Penelitian ini 

bertujuan untuk membentuk ZOM di Kabupaten Ngawi dengan SKATER 

(Spatial ‘K’luster Analysis by Tree Edge Removal) dan membandingkan 

hasilnya dengan ZOM BMKG. Hasil analisis SKATER menghasilkan 

dua kelompok dengan alokasi anggota perkelompoknya berbeda dengan 

anggota ZOM BMKG. Rasio antara simpangan dalam kelompok (Sw) 

dan simpangan antar-kelompok (Sb) ZOM hasil SKATER mempunyai 

nilai yang lebih kecil daripada rasio ZOM BMKG, sehingga dapat 

disimpulkan bahwa kinerja ZOM hasil SKATER lebih baik jika 

dibandingkan dengan ZOM BMKG. 

 

Kata Kunci :  Curah hujan, keragaman, SKATER, zona Musim 
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BY TREE EDGE REMOVAL) 
 

Student Name  : Partini Ningsih 
Student Number  : 1315 105 051 

Department  : Statistics  

Academic Supervisor : Dr. Sutikno, M.Si 
 

 

Abstract 
The grouping of rainfall patterns by making Zone of Season 

(ZOM) has been done by BMKG. The method often used in the 

formation of ZOM is group analysis that does not pay attention to the 

location aspect of the research object whereas the observation unit is 

the location of the rain station, so the spatial aspect should be 

considered in ZOM formation. One method of spatial grouping is 

SKATER analysis.  

The data used in this study is secondary data, sourced from 

BMKG Climatology Station Klas II Karangploso Malang. The variable 

used is monthly rainfall in Ngawi District from 1990-2015. This study 

aims to group ZOM in Ngawi District with SKATER (Spatial 'K'luster 

Analysis by Tree Edge Removal) and compare the results with ZOM 

BMKG results. The results of SKATER analysis resulted in 2 groups 

with different members' allocation of members with members of ZOM 

BMKG. The ratio between group deviation (Sw) and intergroup 

deviation (Sb) ZOM result of SKATER has a value smaller than BMKG 

ZOM ratio, so it can be concluded that the performance of ZOM 

SKATER results better when compared with BMKG ZOM. 

 
Key Words: Rainfall, season zones, SKATER, variantion 
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BAB I 

PENDAHULUAN 
 

1.1 Latar Belakang 

Badan Meteorologi Klimatologi dan Geofisika (BMKG) telah 

melakukan pengelompokan iklim (pola curah hujan) dengan 

membuat Zona Musim (ZOM) untuk berbagai wilayah, tidak 

terkecuali Kabupaten Ngawi yang merupakan salah satu lumbung 

padi di Provinsi Jawa Timur. Berbagai bidang membutuhkan 

informasi iklim, khususnya curah hujan, diantaranya adalah 

bidang pertanian, perikanan, kehutanan, infrastruktur, transportasi 

dan telekomunikasi. Khususnya untuk bidang pertanian, 

informasi iklim menjadi hal yang penting dalam penyesuaian 

masa tanam dan jenis tanaman yang akan ditanam dalam rentang 

waktu tertentu. Apabila akurasi pembentukan ZOM semakin 

tinggi maka diharapkan akan dapat mengurangi dampak negatif 

yang ditimbulkan oleh faktor iklim seperti hujan badai, 

kebanjiran, kekeringan, tanah longsor, dan lain sebagainya. Hasil 

evaluasi terhadap kinerja pemodelan curah hujan menunjukkan 

bahwa terdapat beberapa lokasi ZOM mempunyai kinerja yang 

kurang baik yaitu tingkat akurasinya rendah. Beberapa hal yang 

diduga menyebabkan rendahnya akurasi tersebut, diantaranya 

adalah metode peramalan yang masih belum sesuai maupun 

penentuan ZOM yang sudah tidak sesuai, sehingga perlu 

dilakukan penelitian untuk penentuan ZOM dengan performa 

yang lebih baik. 

Metode yang sering digunakan dalam pembentukan ZOM 

adalah analisis kelompok (cluster analysis) yang tidak mem-

perhatikan aspek lokasi objek penelitiannya. Analisis kelompok 

tradisional bertujuan membagi n objek menjadi k kelompok 

dimana objek yang berada dalam satu kelompok memiliki 

kesamaan satu sama lain dan objek dengan kelompok berbeda 

memiliki ketidaksamaan satu sama lain. Ketidaksamaan ini 

mengacu pada variabel yang diukur pada setiap objek. Ketika 

objek tersebut mempunyai lokasi spasial yang menentukan 
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struktur ketetanggaannya, terdapat pertimbangan dalam penge-

lompokan objek yang dibatasi oleh hubungan spasial. Partisi 

objek pada kelompok homogen secara internal tetapi objek dalam 

kelompok dibatasi oleh ketetanggaan struktur spasial (Lage, 

Assuncao, & Reis, 2001). Analisis pengelompokan zona musim 

mempunyai unit observasi berupa lokasi stasiun atau stasiun 

hujan, sehingga aspek spasial seharusnya menjadi hal yang 

dipertimbangkan dalam pembentukan ZOM.  

Terdapat metode pengelompokan yang tidak mengabaikan 

aspek spasial dalam analisisnya, yang dikenal dengan metode 

regionalisasi. Regionalisasi adalah prosedur klasifikasi khusus 

yang mempertimbangkan aspek spasial daerah (Assuncao, Neves, 

Camaras, & Freitas, 2006). Pada dasarnya, regionalisasi adalah 

bentuk khusus dari klasifikasi, dimana unit spasial dikelompok-

kan berdasarkan kriteria tertentu dan dibatasi oleh contiguity atau 

ketetanggaan (Guo, 2008). Metode regionalisasi digunakan untuk 

mengklasifikasikan daerah berdasarkan fenomena alam tertentu 

sehingga terbentuk klasifikasi wilayah yang karakteristiknya 

homogen dan letaknya berdekatan satu sama lain  (Assuncao et 

al., 2006). Hal tersebut bersesuaian dengan hukum geografi yang 

disampaikan oleh Waldo Tobler, bahwa segala sesuatu ber-

hubungan dengan segala sesuatu yang lain tetapi sesuatu yang 

dekat akan lebih berkaitan dibandingkan sesuatu yang jauh 

(Tobler, 1970). 

Metode SKATER (Spatial ‘K’luster Analysis by Tree Edge 

Removal) diperkenalkan (Lage, Assuncao, & Reis, 2001) sebagai 

salah satu metode regionalisasi yang spesifik untuk analisis 

pengelompokan spasial. SKATER menggunakan algoritma yang 

mentransformasi data-data kewilayahan menjadi grafik-grafik 

partisi. Metode ini melakukan partisi lokasi-lokasi yang tidak 

bertetanggaan dan tidak memiliki kesamaan karakteristik. 

Kelebihan metode SKATER adalah pengelompokannya meng-

gunakan identifikasi ketetanggaan antar-lokasi yang merupakan 

bagian penting dari analisis spasial  (Assuncao et al., 2006). 
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Sebelumnya, metode SKATER pernah digunakan untuk 

mengklasifikasikan faktor-faktor yang mempengaruhi kelahiran 

dan kematian bayi di Kabupaten Bogor, Jawa Barat, hasilnya 

terbentuk 4 kelompok (Bekti & Rachmawati, 2013). Pada 

penelitian lainnya, Bekti mengelompokkan lokasi dengan metode 

SKATER berdasarkan fasilitas air bersih dan sanitasi 

menghasilkan 6 kelompok lokasi dari 23 kecamatan di Kabupaten 

Bekasi, Jawa Barat (Bekti R. D., 2015). Kemudian SKATER 

digunakan pada proses regionalisasi (Guo, 2008). Pengelompokan 
ZOM pernah dilakukan dengan Agglomerative Hierarchical 

Clustering, menghasilkan 5 ZOM dan performanya lebih baik 

daripada ZOM oleh BMKG dilihat dari kriteria rasio Sw dan Sb  

(Alam & Sutikno, 2010). Metode SKATER juga digunakan pada 

pembentukan kelompok daerah sensus sosio-ekonomi di Kota Rio 

de Janeiro, menghasilkan 794 kelompok dari 8145 daerah awal 

(Santos, Chor, & Werneck, 2010). Simulasi penggunaan metode 

SKATER dilakukan pada 240 wilayah di Belo Horizonte, sebuah 

area metropolitan di Brazil. Peneliti mempertimbangkan 100 

skenario dengan 14 kelompok dan pada semua skenario tersebut 

SKATER berhasil menghasilkan seluruh kelompok tanpa ada 

kesalahan (Lage et.al, 2001). Dari penelitian-penelitian 

sebelumnya, diketahui bahwa SKATER mempunyai performa 

yang bagus dalam mengelompokkan objek dengan aspek spasial  

(Bekti & Rachmawati, 2013). 

Variabel yang digunakan dalam penelitian mengenai 

pengelompokan zona musim (ZOM) ini adalah curah hujan 

bulanan di Kabupaten Ngawi. Curah hujan mempunyai 

variabilitas yang besar dalam ruang dan waktu. Dalam skala 

ruang, variabilitasnya sangat dipengaruhi oleh letak geografis, 

topografi, arah angin dan letak lintang. Dalam skala waktu, 

keragaman curah hujan dibagi atas tipe harian, bulanan dan 

tahunan. Variasi curah hujan harian lebih dipengaruhi oleh faktor 

lokal, variasi bulanan dipengaruhi oleh angin moonson, aktivitas 

koneksi, arah aliran udara di permukaan serta variasi sebaran 

daratan dan lautan. Variasi curah hujan tahunan dipengaruhi oleh 
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perilaku kondisi atmosfer  lautan  global,  siklon tropis dan lain-

lain  (Prasetyo, 2011). 

Penelitian ini bertujuan untuk mengelompokkan ZOM 

Kabupaten Ngawi dengan SKATER (Spatial ‘K’luster Analysis 

by Tree Edge Removal) dan membandingkan hasilnya dengan 

ZOM hasil BMKG. Hasil penelitian ini diharapkan dapat 

memberikan alternatif metode untuk penentuan ZOM bagi 

BMKG sehingga dapat mendukung peramalan iklim yang 

semakin akurat dengan mempertimbangkan aspek spasial. 

   

1.2 Rumusan Permasalahan 

Metode yang seringkali digunakan dalam pembentukan ZOM 

adalah analisis kelompok yang tidak memperhatikan aspek lokasi 

objek penelitiannya padahal analisis pengelompokan zona musim 

mempunyai unit observasi berupa lokasi stasiun atau stasiun 

hujan, sehingga aspek spasial seharusnya menjadi hal yang 

dipertimbangkan dalam pembentukan ZOM. Akurasi pada 

pembentukan ZOM sangat dibutuhkan dalam berbagai bidang, 

termasuk bidang pertanian di Kabupaten Ngawi yang merupakan 

salah satu lumbung padi di Provinsi Jawa Timur. Khususnya 

untuk bidang pertanian, informasi iklim menjadi hal yang penting 

dalam penyesuaian masa tanam dan jenis tanaman yang akan 

ditanam dalam rentang waktu tertentu. Salah satu metode 

pengelompokan spasial yaitu SKATER (Spatial ‘K’luster 

Analysis by Tree Edge Removal). Rumusan masalah dalam 

penelitian ini adalah bagaimana hasil pemetaan letak stasiun 

hujan di Kabupaten Ngawi, bagaimana karakteristik serta 

hubungan dependensi spasial curah hujan di Kabupaten Ngawi, 

bagaimana pengelompokan ZOM di Kabupaten Ngawi 

berdasarkan metode SKATER, bagaimana perbandingan hasil 

pengelompokan ZOM di Kabupaten Ngawi antara metode 

SKATER dan ZOM hasil BMKG serta apakah ada perbedaan 

rata-rata curah hujan antar-kelompok yang terbentuk. 
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1.3 Tujuan 

Tujuan  penelitian ini adalah sebagai berikut.  

1. Memetakan letak stasiun hujan di Kabupaten Ngawi dengan 

metode Thiessen Polygons. 

2. Mendeskripsikan karakteristik dan menguji dependensi 

spasial curah hujan di Kabupaten Ngawi. 

3. Mengelompokkan ZOM di Kabupaten Ngawi dengan metode 

SKATER. 

4. Membandingkan hasil pengelompokan ZOM antara metode 

SKATER dengan ZOM oleh BMKG, menguji perbedaan 

rata-rata curah hujan antar-kelompok yang terbentuk, serta 

mendapatkan ZOM terbaik. 

 

1.4 Manfaat Penelitian 

Hasil penelitian ini diharapkan dapat memberikan informasi 

dan alternatif bagi BMKG dalam menentukan zona musim di 

Kabupaten Ngawi. Manfaat bagi peneliti dapat menerapkan 

analisis kelompok spasial untuk menghasilkan pengelompokan 

zona musim.  
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BAB II 

TINJAUAN PUSTAKA 
 

Pada bab ini dibahas mengenai konsep dan teori metode yang 

digunakan dalam melakukan analisis untuk menjawab perumusan 

masalah penelitian. Metode yang digunakan diantaranya adalah 

statistika deskriptif, uji dependensi spasial Moran’s I, metode 

SKATER dan uji t berpasangan. Pembahasan mengenai konsep 

dan teori yang digunakan dalam analisis adalah sebagai berikut. 

2.1 Statistika Deskriptif 
Statistika deskriptif merupakan metode mengeksplorasi dan 

membuat kesimpulan pola pada data (Agresti & Franklin, 2007). 

Dalam penelitian ini, karakteristik data akan dilihat dari rata-rata 

dan standar deviasinya dengan penjelasan singkat sebagai berikut. 

1) Mean (Rata-Rata) 

Mean adalah jumlah nilai pada data pengamatan dibagi 

dengan banyaknya pengamatan. Rumus yang digunakan untuk 

menghitung mean adalah 

n

x

x

n

i

i
 1

 
dimana xi = besarnya data ke-i, n = banyaknya data, dan i =1, 2, 

…, n. 

2) Standar Deviasi 

Standar deviasi adalah rata-rata deviasi (selisih antara 

pengamatan dengan rata-rata sampel). 

1

)(

1

2










n

xx

s

n

i

i

 

dimana xi = besarnya data ke-i, n = banyaknya data, dan i =1, 2, 

…, n. Selain mean dan standar deviasi, dalam analisis deskriptif 

akan digunakan minimum (nilai terkecil), maksimum (nilai 

terbesar),  dan range (selisih antara maksimum dan minimum). 
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2.2 Box Plot 
Box plot atau box and whisker plot terdiri atas lima ukuran 

statistik, seperti yang disajikan pada Gambar 2.1. Kotak (box) 

menunjukkan nilai kuartil 1 dan kuartil 3 (Q1 dan Q3) dan terbagi 

dua oleh median (Q2). Terdapat IQR (Inter Quartil Range) yaitu 

selisih antara Q1 dan Q3. Melalui box plot dapat dilihat apakah 

data terdistribusi secara simetris atau tidak dan juga dapat dilihat 

apakah data mempunyai ekor yang panjang  (Ajit & Dorothy, 

2000).  Gambar 2.1 menunjukkan contoh box plot. 

 

 
Gambar 2.1 Ilustrasi Box Plot 

  

2.3 Uji Signifikansi Moran’s I 

Menurut Lembo (2006) dalam (Kartika, 2007), autokorelasi 

spasial adalah ukuran kemiripan dari objek di dalam suatu ruang 

(jarak, waktu dan wilayah). Autokorelasi spasial adalah korelasi 

antara variabel dengan dirinya sendiri berdasarkan ruang. Apabila 

terdapat pola sistematik dalam penyebaran sebuah variabel, maka 

terdapat autokorelasi spasial. Hal itu mengindikasikan bahwa 
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nilai atribut pada daerah tertentu terkait oleh nilai atribut tersebut 

pada daerah yang letaknya berdekatan atau bertetanggaan. 

Terdapat beberapa metode autokorelasi spasial, salah satunya 

adalah statistik Moran’s I. Sebagaimana korelasi Pearson, nilai 

korelasi Moran’s I serta nilai ekspektasi dan variansnya dapat 

diperoleh dari formula sebagai berikut  (Paradis, 2013). 

   

 





 






n

i
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n

i

n

j
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b

xx

xxxxw

S

n
I

1

2

1 1

0

ˆ  

Ib adalah indeks Moran’s I untuk curah hujan bulan ke-b, xib 

adalah curah hujan pada stasiun ke-i bulan ke-b, xjb adalah curah 

hujan pada stasiun ke-j bulan ke-b, bx adalah rata-rata curah hujan 

bulan ke-b, wij adalah elemen matrik pembobot antara stasiun ke-i 

dan stasiun ke-j, S0 adalah jumlahan elemen matrik pembobot 

dimana 
 


n

i

n

j

ijwS
1 1

0 , n adalah banyaknya stasiun hujan 

dimana n = 1,2,..., 25, b adalah banyaknya bulan dimana b = 

1,2,..., 12. Matrik pembobot spasial yang digunakan dalam 

penelitian ini adalah Queen Contiguity yang memperhatikan 

persinggungan sisi dan sudut. Matrik pembobot wij berukuran nxn, 

dimana setiap elemennya menggambarkan ukuran kedekatan 

antara pengamatan  i dan j. 

Nilai dari indeks Î  berada diantara -1 dan 1. Apabila Î  > I0 

maka terjadi autokorelasi positif pada data atau pola 

mengelompok, jika Î  < I0  maka terjadi autokorelasi negatif atau 

pola menyebar, dan jika Î  = I0 maka tidak ada autokorelasi atau 

pola menyebar tidak merata. I0 merupakan nilai ekspektasi dari 

bÎ , dirumuskan sebagai berikut. 

1

1
)ˆ( 0




n
IIE b  
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Koefisien Moran’s I digunakan untuk menguji independensi 

spasial atau autokorelasi antar pengamatan atau lokasi, dengan 

hipotesis sebagai berikut. 

H0 : Tidak ada autokorelasi antar-lokasi 

H1 : Ada autokorelasi antar-lokasi 

Statistik ujinya yaitu  )1,0(

)ˆvar(

)ˆ(ˆ
N

I

IEI
Z

b

bb
hitung 
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Tolak H0 apabila )2/1(  ZZ hitung . Nilai autokorelasi spasial 

yang positif mengindikasikan bahwa antar-lokasi pengamatan 

mempunyai keeratan hubungan (Lee & Wong, 2000). 

 

2.4 Metode Thiessen Polygons 

 Data hujan yang diperoleh dari alat penakar hujan merupakan 

hujan yang terjadi hanya pada satu tempat atau titik saja (point 

rainfall). Karena hujan sangat bervariasi terhadap tempat (space), 

maka untuk kawasan yang luas, satu penakar hujan belum dapat 

menggambarkan hujan wilayah tersebut. Dalam hal ini diperlukan 
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hujan kawasan yang diperoleh dari harga rata-rata curah hujan 

beberapa stasiun penakar hujan yang ada di dalam/atau disekitar 

kawasan tesebut (Ningsih, 2012).  

Metode Thiessen Polygon, atau juga disebut diagram 

Voronoi, diperoleh dengan membuat poligon yang memotong 

tegak lurus pada tengah-tengah garis penghubung antara dua 

stasiun hujan. Dengan demikian tiap stasiun penakar Rn akan 

terletak pada suatu wilayah poligon tertentu An. Berikut gambaran 

perhitungan Thiessen Polygons melalui Gambar 2.2. Poligon 

yang terbentuk mengilustrasikan kawasan yang tinggi curah 

hujannya diwakili oleh stasiun penakar hujan yang ada di dalam 

area poligon tersebut. 

 
Gambar 2.2 Ilustrasi Thiessen Polygons 

Sumber : (Ningsih, 2012). 

 

2.5 Metode SKATER 

Metode SKATER menggunakan tipe data polygon sebagai 

inputannya, yaitu tipe data yang menggambarkan suatu 

area/wilayah. Dalam SKATER terdapat dua langkah analisis 

untuk membentuk kelompok dengan karakteristik yang cenderung 

sama. Langkah pertama adalah membangun Minimum Spanning 

Tree (MST) berdasarkan algoritma Prim pada grafik konektivitas. 

Langkah kedua yaitu membuat partisi MST, yang dilakukan 

dengan penghapusan edge yang menghubungkan wilayah-wilayah 
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yang besar perbedaannya sehingga akan diperoleh hasil subtrees 

yang merepresentasikan region akhir yang terbentuk (Assuncao et 

al., 2006). Pengolahan data untuk pengelompokan dengan metode  

‘K’luster Analysis by Tree Edge Removal (SKATER) dapat 

dilakukan di software R menggunakan package spdep, maptools, 

lattice, dan gstat  (Bekti R. D., 2015) atau dapat dilakukan analisis 

dengan implementasi library TERRALIB pada software 

TERRAVIEW (Gilberto, L'ubia, Ferreira, De, Cartaxo, Souza , 

2008). 

Misalkan suatu kelompok lokasi O dengan variabel {A1, ..., 

An}. Setiap lokasi memiliki vektor variabel x = {a1, a2, ..., an} 

dimana a1 adalah sebuah kemungkinan nilai dari variabel A1. 

Topologi dari satu set data menunjukkan grafik konektivitas G = 

(V, L) dengan satu set simpul V dan satu set edge L. Koneksi antar 

simpul vi dan vj terjadi apabila lokasi i dan j saling berdekatan 

(bertetanggaan). Edge (vi, vj) dinyatakan sebagai cost d(i,j) 

dengan mengukur ketidaksamaan antara objek i dan j 

menggunakan vektor variabel xi dan xj. Pengukuran ketidak-

samaan ini tergantung pada konteks. Jarak kedekatan diukur 

berdasarkan jarak Euclidean pada setiap lokasi. Formula jarak 

Euclidean untuk vektor xi dan xj adalah sebagai berikut. 

2
1

1

2)(),(),(













 



b

l

jlilji xxdjid xx  

Jalur dari simpul v1 ke simpul vk merupakan urutan simpul 

(v1, v2, ..., vk) yang dihubungkan oleh edge (v1, v2)..., (vk -1, vk ). 

Grafik G terhubung jika terdapat dua simpul, simpul vi  dan 

simpul vj ,  kemudian setidaknya terdapat satu jalur yang meng-

hubungkan keduanya. Kelompok spasial yang akan dibentuk 

merupakan  kumpulan dari smpul-simpul yang terhubung.  

Tujuannya adalah untuk membagi grafik G menjadi C kelompok 

spasial G1, ..., GC  dimana kumpulannya merupakan G dan 

masing-masing kelompok adalah sub-grafik terhubung.  

 Sirkuit adalah jalur yang simpul pertama dan simpul 

akhirnya sama, dan pohon adalah grafik yang terhubung tanpa 
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sirkuit. Spanning tree T dari grafik G adalah pohon yang 

mengandung semua n simpul dari G, dimana dua simpul dari G 

dihubungkan oleh jalur yang unik, dan jumlah edge di T adalah n 

-1. Penghapusan edge manapun dari T menghasilkan dua sub-

grafik terpisah yang merupakan calon kelompok-kelompok 

spasial. Spanning Minimum Tree (MST) adalah pohon rentang 

(spanning tree) dengan cost minimum, dimana cost diukur 

sebagai jumlah selisih dari semua edge pohon. MST unik jika cost 

antara simpul dan semua tetangganya nilainya berbeda.   

 Berikut ini adalah penjelasan langkah analisis untuk 

membentuk kelompok dengan metode SKATER. 

1) Menentukan Minimum Spanning Tree (MST) 

Pembentukan MST dilakukan berdasarkan algoritma Prims 

dengan membentuk koneksi antar-simpul dan edge pada setiap 

lokasi (Assuncao et al., 2006). Misalkan grafik konektivitas G = 

(V, L) yang terdiri dari beberapa simpul (V) dan edge (L). 

Algoritma dimulai dengan sebuah pohon pertama, T1, yang hanya 

memiliki satu sumbu. Pada setiap iterasi, ditambahkan edge baru 

dan simpul yang baru pada pohon yang dibuat. Pada iterasi n, Tn  

terdiri dari semua n simpul V dan sebuah subset Lm dari L dengan 

n–1 edge. Jumlah cost yang berkaitan dengan edge dalam Lm 

adalah minimum. Berikut algoritma yang dilakukan untuk 

membentuk MST. 

1.  Pilih suatu vi dari V, maka didapatkan Tk = T1 = ({vi},  ) 

2.  Memilih edge dari cost terkecil (l’) dari L yang 

menghubungkan simpul Tk dan  simpul lainnya, vj, milik V 

bukan Tk 

3.  Pilih vj dan l’ pada pohon Tk dan kemudian susun pohon baru 

Tk+1 

4.  Ulangi langkah kedua hingga semua simpul masuk ke dalam 

pohon Tn. 

 

Gambar 2.3 memperlihatkan prosedur untuk membentuk 

MST dari tiga iterasi pertama dan iterasi terakhir. Apabila 
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terdapat lebih dari satu edge yang cost-nya minimum dalam 

langkah ke-dua, maka MST tersebut tidak unik. Pada kasus ini, 

MST dapat tergantung pada pemilihan sumbu vi  (pada langkah 

pertama algoritma) dan menjadi evaluasi cost pada langkah ke-

dua. Bagaimanapun, pada grafik yang berkaitan dengan dan 

sosio-ekonomi, hal tersebut tidak mungkin terjadi  (Assuncao et 

al., 2006). 

 
Gambar 2. 3 Menentukan Minimum Spanning Tree (MST) 

Sumber : (Assuncao et al., 2006). 
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2) Membuat Partisi MST 

Setelah terbentuk MST, SKATER melakukan partisi rekursif 

dari MST untuk mendapatkan pengelompokan (Assuncao et al., 

2006). Hasil pengelompokan adalah adanya homogenitas variabel 

di dalam kelompok. Untuk membentuk partisi dari n objek pada k 

wilayah, dilakukan penghapusan k-1 edge dari MST. Masing-

masing akan menghasilkan kelompok yang berbentuk pohon. 

Pembentukan partisi dari n objek pada k wilayah dilakukan 

dengan strategi pembagian hierarki (hierarchical division 

strategy). Awalnya, seluruh objek masuk dalam sebuah pohon 

yang sama. Selanjutnya akan ada proses penghapusan edge dari 

MST asli. Pada setiap iterasi, pohon dibagi menjadi dua dengan 

memotong sebuah edge sampai dengan terbentuknya kelompok 

yang telah ditetapkan. 

Partisi tersebut menghasilkan grafik G* yang terdiri dari 

pohon T1, T2, ..., Tn dimana setiap pohon akan terkoneksi namun 

tidak memiliki simpul ataupun edge dengan pohon lain. Pada 

iterasi pertama, G* hanya berupa sebuah pohon tunggal, yang 

merupakan MST.  Di setiap iterasi, dilakukan pemeriksaan pada 

grafik G* dan mengambil sebuah edge yang akan membagi pohon 

Ti menjadi dua bagian yaitu Ti
1 

dan Ti
2 

. Hal ini merupakan proses 

pemecahan wilayah menjadi dua sub-wilayah. Pemilihan edge 

menggunakan jumlah kuadrat deviasi antar kelompok (SSDi), 

yaitu meminimumkan 

  




k

i

iSSDQ

1

 

Dimana   adalah partisi dari objek menjadi k pohon;  Q  

adalah nilai yang berkaitan dengan kualitas dari partisi  ; dan 

iSSD  adalah jumlah kuadrat deviasi dalam wilayah i. 

Jumlah kuadrat deviasi dalam kelompok (SSDi) dihitung dari 

penyebaran nilai variabel pada objek dalam sebuah wilayah. 

Wilayah yang homogen akan memiliki nilai SSD yang kecil. 

Sehingga semakin kecil  Q  maka semakin baik partisinya. SSD 

diformulasikan sebagai berikut. 
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Dengan nk adalah banyaknya objek spasial pada pohon k ; 

ijx adalah variabel ke-j dari objek spasial i ; m adalah banyaknya 

variabel dalam analisis; dan jx  adalah nilai rata-rata variabel ke-j 

dari seluruh objek pada pohon k. 

Pada setiap iterasi, dilakukan penghapusan edge dari grafik 

G* yang terdiri dari pohon T1, ..., Tn dengan membandingkan 

solusi optimum untuk setiap pohon T1, ..., Tn . Solusi terbaik yang 

dapat membagi pohon T dinotasikan sebagai 
RS*  berdasarkan 

pada fungsi objektif: 

)()(1 TbTaT

T

l SSDSSDSSDSf   

T

lS adalah gubahan hasil dari pemotongan edge l dari pohon 

T, dan Ta dan Tb adalah dua pohon yang dihasilkan dari 

pemotongan edge l dari pohon T. 

Pada setiap iterasi, dilakukan pembagian pohon Ti yang 

memiliki nilai tertinggi pada fungsi objektifnya )( *1
iT

Sf . Idenya 

adalah untuk memperoleh peningkatan kualitas terbesar pada 

setiap langkahnya. Dimulai dari sebuah MST, dapat dibuat 

kelompok sebagai berikut. 

1. Mulai dengan grafik G* = (T0) dimana T0 = MST 

2. Identifikasi edge yang memiliki fungsi objektifnya 

tertinggi 0

*

T
S  

3. Selama (G*) < k (jumah kelompok yang ditentukan), 

ulangi langkah 4 dan 5 

4. Untuk semua pohon G*, pilih pohon Ti dengan fungsi 

objektif )( *1
iT

Sf  yang terbaik. 

5. Membagi Ti menjadi dua sub-pohon yang baru dan 

memperbarui G* 
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Gambar 2.4 berikut memperlihatkan tiga iterasi pertama 

dalam membuat partisi MST  (Assuncao et al., 2006).  

 
Gambar 2.4 Proses Partisi MST 

  Sumber : (Assuncao et al., 2006). 

 

Cara mendapatkan partisi MST dengan cepat dapat dilakukan 

dengan mengetahui edge terbaik yang membagi subtree dari 

kandidat terbaik dalam ruang solusi S yaitu S={S1, S2, ..., Sn-1}, 

dimana kandidat Sl  adalah penghapusan edge  l dari pohon.  

 Algoritma untuk mencari solusi optimum dengan 

menganalisis tetangga kandidat. Langkah optimasi dapat dimulai 

dengan mengevaluasi solusi Si pada titik saat ini dan solusi pada 

lingkungan terdekatnya. Gambar 2.5 menunjukkan bagaimana 

melakukan ekspansi kedekatan di ruang solusi. Sebagai contoh, Si  

mempunyai empat tetangga yaitu Sj, Sk , Sl dan Sm. Evaluasi dapat 
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dilakukan pada kelima solusi dan melacak solusi dengan fungsi 

objektif f1 (Si). 

 
Gambar 2. 5 Ekspansi Kedekatan Solusi Si 

Sumber : (Assuncao et al., 2006). 
 

Fungsi objektif kedua, f2, digunakan untuk memilih solusi 

yang membagi pohon menjadi dua kelompok yang lebih homogen 

dan imbang. Nilai f2 adalah nilai terkecil dari selisih antara nilai 

SSD pada pohon saat ini dan nilai SSD dari dua subtrees hasil 

pemotongan dari nilai sebagai berikut. 

    TbTTaT2 SSDSSD,SSDSSDmin f  

 Pemilihan titik awal dapat mengurangi iterasi dalam 

menemukan solusi optimum. Seperti halnya pada metode 

pembagian hierarki, titik awal yang baik adalah titik yang 

terdapat pada tengah/pusat pohon. Titik pusat dapat ditentukan 

dengan mengidentifikasi edge yang membagi pohon menjadi dua 

subtrees dengan ukuran yang sama. Selanjutnya, dapat dilakukan 

optimasi dengan menggunakan dua fungsi objektif. Stopping 

Condition (SC) pada strategi eksplorasi adalah jumlah iterasi 

maksimum tanpa pertumbuhan nilai f1. Berikut kesimpulan dari 

optimasi heuristik  (Assuncao et al., 2006). 

1. Mulai dari titik pusat, Vc. Masukkan solusi yang berkaitan 

dengan edge pada Vc dalam daftar solusi potensial, Sp. 

Tetapkan n* = n = 0 dan f1(S*) = 0. 

2. Mengevaluasi solusi-solusi dalam  Sp dan menyimpannya 

dalam daftar L. 
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3. Memperbarui informasi solusi terbaik. Memilih solusi Sj dalam 

Sp dengan fungsi objektif terbesar  f1(Sj). Jika f1(Sj) > f1(S*) 

maka S* = Sj dan n* = n.  

4. Tetapkan n = n + 1. Berdasarkan fungsi balancing f2(Sj), pilih 

sebuah solusi dari daftar L yang akan memiliki lingkungan 

yang diperluas, lalu mulailah membuat daftar solusi potensial 

Sp yang baru. 

5. Memeriksa stopping condition  (n - n* > SC). Jika salah, maka 

kembali ke langkah ke-2. Sebaliknya, jika benar maka pilih S* 

sebagai solusi terbaik yang ada, dan proses selesai.  

  

Prosedur tersebut akan diulangi iterasinya hingga kriteria SC 

(kandidat solusi tidak berubah pada saat jumlah iterasi tertentu) 

sudah terpenuhi. Daerah populasi yang seimbang tidak 

dipertimbangkan dalam prosedur regionalisasi ini. Asumsi yang 

diberlakukan dalam prosedur tersebut adalah: 

S* adalah solusi terbaik sementara yang pada saat penyelesaian 

akan mewakili solusi terpilih; 

n  adalah jumlah iterasi; 

n* adalah iterasi terakhir dimana peningkatan fungsi objektif f1 

terjadi; 

Sp adalah daftar solusi potensial pada iterasi saat ini; 

L  adalah daftar calon yang telah dievaluasi namun belum 

diperluas; 

Sj adalah solusi terbaik pada daftar solusi potensial Sp saat ini 

dimana identifikasinya dilakukan setelah mempertimbangkan 

semua solusi dalam Sp; 

Stopping Condition (SC) adalah adalah kondisi berhenti mencari, 

yang didefinisikan sebagai jumlah iterasi tanpa perbaikan di f1. 
 

2.6 Kriteria Kebaikan Zona Musim 

Kriteria kebaikan ZOM yang terbentuk dari analisis 

pengelompokan akan dilihat berdasarkan dua nilai simpangan 
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baku, yaitu dalam-kelompok (SW) serta antar-kelompok (SB) 

dengan rumus sebagai berikut. 





K

k

kW SKS
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Sk adalah simpangan baku kelompok ke-k dan K adalah 

banyaknya kelompok yang terbentuk. 

2

1

1
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k
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kX adalah rataan kelompok ke-k dan X adalah rataan 

keseluruhan kelompok. 

Kedua nilai simpangan baku tersebut digunakan untuk 

menentukan hasil perbandingan antara ZOM yang dihasilkan dari 

metode SKATER dan ZOM dari BMKG. Semakin kecil nilai SW 

dan semakin besar nilai SB maka metode pengelompokan tersebut 

mempunyai kinerja yang baik karena itu berarti homogenitas 

dalam kelompoknya tinggi (Bunkers, Miller, & DeGaetano, 

1996). 

 

2.7 Uji t Berpasangan 

Uji t berpasangan (t-paired test) bertujuan untuk menguji 

perbedaan rata-rata dua kelompok yang berpasangan  (Walpole, 

Myers, Myers, & Ye, 2011). Uji t berpasangan memerlukan 

asumsi normalitas. Dalam penelitian ini digunakan uji normalitas 

dengan Saphiro Wilk karena dinilai efektif dan valid untuk 

sampel berjumlah kecil, yaitu hanya melibatkan 12 bulan amatan.  

Hipotesis uji t berpasangan adalah: 

H0 : µ1 - µ2 = 0  (rata-rata kedua kelompok adalah sama) 

H1 : µ1 - µ2 ≠  0 (rata-rata kedua kelompok adalah berbeda) 

Taraf siginifikan (α) = 5%. Tolak H0 apabila P-value < α atau 

|thitung | > ttabel dimana ttabel = t(α/2); (n-1) 
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Statistik uji : 
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dimana d adalah selisih rata-rata curah hujan bulanan antara dua 

kelompok, dX  adalah rata-rata selisih, n adalah jumlah sampel, sd 

adalah simpangan baku dari d. 

 

2.8 Curah Hujan dan Zona Musim 

Curah hujan merupakan salah satu unsur cuaca yang datanya 

diperoleh dari hasil pengukuran dengan menggunakan alat 

penakar hujan, sehingga dapat diketahui jumlahnya dalam satuan 

millimeter (mm). Curah hujan 1 mm adalah jumlah air hujan yang 

jatuh di permukaan per satuan luas (m
2
) dengan catatan tidak ada 

yang menguap, meresap atau mengalir. Jadi, curah hujan sebesar 

1 mm setara dengan 1 liter/m
2
. Curah hujan dibatasi sebagai 

tinggi air hujan yang diterima di permukaan sebelum mengalami 

aliran permukaan, evaporasi dan peresapan ke dalam tanah 

(Aldrian, Budiman, & Karmini, 2011). 

Zona Musim (ZOM) adalah wilayah yang mempunyai batas 

yang jelas antara periode musim hujan dan periode musim 

kemarau. Non ZOM adalah wilayah yang tidak mempunyai batas 

yang jelas antara periode musim hujan dan musim kemarau, yang 

selanjutnya disebut daerah Non Zona Musim (Non ZOM). Batas 

wilayah ZOM tidak mengikuti batas administrasi pemerintahan. 

Dimana, satu wilayah ZOM bisa terdiri dari beberapa kabupaten, 

dan sebaliknya satu wilayah kabupaten bisa terdiri dari beberapa 

ZOM (Balai Besar Penelitian Tanaman Padi, 2015).   
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BAB III 

METODOLOGI PENELITIAN 
 

3.1 Sumber Data 

Data yang digunakan dalam penelitian ini adalah data 

sekunder yang meliputi data curah hujan bulanan pada periode 

tahun 1990-2015 di Kabupaten Ngawi, bersumber dari BMKG 

Stasiun Klimatologi Klas II Karangploso Malang. Gambar 3.1 

berikut menggambarkan letak stasiun hujan di Kabupaten Ngawi 

dilengkapi dengan urutan label ID stasiun pos hujan sesuai Tabel 

3.1. 

 
 

 

 

 

 

 

 

 

 

 

 

Gambar 3. 1 Zona Musim di Kabupaten Ngawi 

 

3.2 Variabel Penelitian 

Variabel yang digunakan dalam penelitian ini adalah curah 

hujan (mm) bulanan pada setiap stasiun hujan di Kabupaten 

Ngawi. Terdapat 25 stasiun hujan di Kabupaten Ngawi yang 

dijadikan objek pengamatan dalam penelitian ini sebagaimana 

disajikan pada Tabel 3.1 berikut. 

 

ZOM 1 ZOM 2 
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Tabel 3. 1 Stasiun Hujan Kabupaten Ngawi 

ID Nama Stasiun 
Koordinat Elevasi 

(mdpl) Lintang Bujur 

1 Ngrambe -7,513 111,198 430 

2 Babadan -7,504 111,220 368 

3 Dawung/Jogorogo -7,499 111,261 252 

4 Kendal -7,560 111,289 74 

5 Keras Kulon -7,529 111,423 88 

6 Guyung -7,506 111,410 69 

7 Tepas/Pg Sudhono -7,495 111,433 70 

8 Budug -7,544 111,536 66 

9 Legundi/Karangjati -7,461 111,613 32 

10 Kedungbendo -7,387 111,543 137 

11 Cangaan/Padas -7,420 111,504 82 

12 Kedungprahu/Sambiroto -7,445 111,221 82 

13 Jururejo/Mardiasri -7,428 111,406 70 

14 Margomulyo/Ngawi -7,404 111,446 59 

15 Karangasri/Kedung Urung-Urung -7,510 111,164 440 

16 Gentong/Bekoh -7,500 111,301 154 

17 Paron -7,437 111,396 69 

18 Begal -7,469 111,271 162 

19 Kedung Galar -7,408 111,312 91 

20 Gemarang/Sokongadirejo -7,396 111,366 86 

21 Kricak -7,394 111,344 78 

22 Ngancar/Papungan -7,383 111,369 57 

23 Banyubiru/Tretes -7,453 111,172 202 

24 Widodaren/Wali Kukun -7,385 111,223 73 

25 Kedungharjo/Mantingan -7,386 111,150 113 
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Data curah hujan dari masing-masing stasiun hujan 

Kabupaten Ngawi dihitung rata-rata setiap bulannya, mulai dari 

tahun 1990 hingga 2015. Struktur data pada penelitian ini 

ditampilkan pada Tabel 3.2 sebagai  berikut. 

 
Tabel 3. 2 Struktur Data Awal 

ID 

Stasiun 

(i) 

Tahun 
Curah Hujan (j) 

Jan Feb Mar ... Des 

1 1990      

 

1991 
    

 

 

. 
    

 

 

. 
    

 

 

. 

     

 

2015           

 

Jumlah   11x   12x   13x  
...

  
  12.1x  

2 1990 
    

 

 

1991 
    

 

 

. 
    

 

 

. 
    

 

 

. 

     

 

2015           

 

Jumlah   21x   22x   23x  
...

   12.2x  

. 

      . 

      . 

      
25 1990           

 

1991 
    

 

 

. 
    

 

 

. 
    

 

 

. 

     

 

2015           

 

Jumlah   1,25x

 

 2,25x

 

 3,25x

 

... 

 

 12.25x
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Kemudian, struktur data Tabel 3.2 diatas dapat diringkas 

menjadi seperti Tabel 3.3  sebagai input data dalam proses 

pengolahan dan analisis pembentukan ZOM-nya. 

Tabel 3. 3 Struktur Data Input 

ID Stasiun 

(i) 
Nama Stasiun 

Rata-Rata Curah Hujan bulan ke-b 

Jan Feb Mar ... Des 

1 
 

 
11x   

12x   13x  ...  
 12,1x  

2 
 

 
21x   

22x   23x  ...   12,2x  

. 
 

. . . 
 

. 

. 
 

. . . 
 

. 

. 

 

. . . 

 

. 

25   
 1,25x   2,25x   3,25x  

...  
 12,25x  

11x  adalah rata-rata curah hujan di stasiun hujan ke-1 di bulan ke-

1 (Januari), 
12x adalah rata-rata curah hujan di stasiun hujan ke-1 

di bulan ke-2 (Februari), dan seterusnya. Secara umum, ibx  

adalah rata-rata curah hujan di stasiun hujan ke-i di bulan ke-b, 

dimana i = 1, 2, ..., 25 dan b =  1, 2, ..., 12. 

3.3 Langkah Analisis Data 

Berikut langkah analisis yang digunakan dalam melakukan 

penelitian ini.  

1. Untuk menjawab tujuan pertama, dilakukan pemetaan dengan  

metode Theissen Polygons untuk menampilkan peta 

Kabupaten Ngawi berdasarkan lokasi stasiun hujannya. 

Pemetaan ini menggunakan software QGIS 2.8.4 

2. Untuk menjawab tujuan ke-dua, dilakukan analisis deskriptif 

dan menguji autokorelasi antar-lokasi  

1) Karakteristik tinggi curah hujan tiap stasiun di Kabupaten 

Ngawi ditampilkan dalam bentuk tabel, grafik dan box-

plot. 
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2) Uji autokorelasi antar-lokasi (stasiun hujan) dilakukan 

dengan menggunakan uji Moran’s I. 

3. Untuk menjawab tujuan ke-tiga, dilakukan analisis SKATER 

dengan langkah-langkah sebagai berikut: 

1) Menentukan jumlah kelompok paling optimum dengan 

membandingkan nilai simpangan dalam kelompok (Sw), 

simpangan antar-kelompok (Sb) serta rasio Sw dan Sb. 

Kelompok dengan rasio Sw Sb terkecil adalah jumlah 

kelompok yang akan dipilih. 

2) Menentukan Minimum Spanning Tree (MST) berdasarkan 

algoritma Prims pada grafik konektivitas. 

3) Melakukan partisi MST untuk mendapatkan 

pengelompokan, dilakukan dengan penghapusan edge 

yang menghubungkan wilayah-wilayah yang besar 

perbedaannya sehingga akan diperoleh hasil subtrees 

yang merepresentasikan region akhir yang terbentuk. 

4) Mendapatkan hasil pengelompokan berdasarkan metode 

SKATER dan mendeskripsikan karakteristiknya. 

4. Untuk menjawab tujuan ke-empat, dilakukan analisis dengan 

langkah-langkah sebagai berikut: 

1) Membandingkan karakteristik anggota ZOM BMKG 

dengan ZOM yang dihasilkan dengan metode SKATER. 

2) Menguji kesamaan rata-rata antara ZOM BMKG dengan 

ZOM SKATER. 

3) Menghitung dan membandingkan kriteria SW dan SB pada 

ZOM BMKG maupun ZOM SKATER  

4) Mendapatkan ZOM terbaik. 

 

 Gambar 3.2 berikut merupakan diagram alir analisis data. 
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Gambar 3.2 Diagram Alir Analisis Data 

 

Analisis SKATER  

 

 

 

 

 

 

 

 

 

 

Menentukan Minimum Spanning Tree (MST) 

Menentukan partisi rekursif MST 
 

Menentukan jumlah kelompok optimum 
 

Mendapatkan hasil pengelompokan SKATER 
 

Mendapatkan ZOM terbaik 

 

Membandingkan SW dan SB   

hasil ZOM  SKATER dan ZOM BMKG  

Membandingkan karakteristik dan menguji rata-

rata ZOM BMKG dan ZOM  SKATER 

 

Statistika deskriptif dan uji autokorelasi data 

curah hujan bulanan di Kabupaten Ngawi   

 

Pemetaan titik stasiun hujan dengan  metode 

Theissen Polygons dengan QGIS 2.8.4 

Data curah hujan  di 

Kabupaten Ngawi   
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BAB IV 

ANALISIS DAN PEMBAHASAN 
  

4.1 Pemetaan Titik Lokasi Stasiun Hujan  

 Pemetaan titik lokasi 25 stasiun hujan Kabupaten Ngawi 

dilakukan dengan  menggunakan metode Thiessen Polygons 

(Gambar 4.1). Beberapa langkah pembuatan peta stasiun hujan 

dengan Thiessen Polygons dijelaskan pada Lampiran 2. Poligon 

yang terbentuk mengilustrasikan kawasan yang tinggi curah 

hujannya diwakili oleh stasiun penakar hujan yang berada di 

dalam area poligon tersebut. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 4.1 Stasiun Hujan Kabupaten Ngawi  dengan Thiessen 

   Polygons. 

 

 

4.2 Deskripsi Tinggi Curah Hujan Bulanan  
Deskripsi tinggi curah hujan di Kabupaten Ngawi untuk 

mengetahui informasi awal tentang pola data yang akan dilakukan 

analisi lebih lanjut. Nilai mean, standar deviasi, minimum, 

 

ZOM 1 ZOM 2 
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maksimum dan range tinggi hujan Kabupaten Ngawi ditunjukkan 

pada Tabel 4.1. 
 

Tabel 4.1 Mean, Standar Deviasi, Minimum, Maksimum dan Range  

Tinggi Curah Hujan Bulanan (mm) 

Bulan Mean Stdev Min Max Range 

Januari 261,602 71,932 112,615 404,000 291,385 

Februari 259,322 61,673 108,269 402,654 294,385 

Maret 262,563 58,042 140,538 365,077 224,538 

April 209,741 46,855 95,269 291,308 196,038 

Mei 97,346 24,197 50,154 139,538 89,385 

Juni 50,882 16,306 12,808 82,538 69,731 

Juli 25,276 8,907 10,192 47,769 37,577 

Agustus 11,747 6,425 1,346 28,769 27,423 

September 21,151 8,738 5,000 42,692 37,692 

Oktober 97,593 32,816 24,615 177,769 153,154 

November 212,957 84,395 93,442 555,462 462,019 

Desember 233,186 51,497 84,192 334,385 250,192 

 

Rata-rata curah hujan pada bulan Maret adalah yang tertinggi 

di Kabupaten Ngawi, sebesar 262,563 mm, disusul oleh rata-rata 

curah hujan pada Januari dan Februari yang tidak jauh berbeda. 

Hal tersebut menunjukkan bahwa puncak musim penghujan 

Kabupaten Ngawi  adalah pada bulan Maret. Sedangkan curah 

hujan di bulan Agustus adalah yang terendah, yaitu 11,747 mm, 

berarti puncak musim kemarau di Kabupaten Ngawi terjadi pada 

bulan Agustus. Standar deviasi terbesar dari curah hujan di 

Kabupaten Ngawi adalah pada bulan November. Hal itu 

menunjukkan bahwa variasi curah hujan di Kabupaten Ngawi 

pada bulan November yang terbesar. Nilai range atau selisih 

antara minimum dan maksimum besar menunjukkan range yang 

besar, artinya tingkat curah hujan di setiap stasiun hujan di 

Kabupaten Ngawi tinggi.  
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Gambar 4.2 menunjukkan bahwa curah hujan di Kabupaten 

Ngawi bersifat monsun. Hal tersebut dapat dilihat dari pola curah 

hujannya yang membentuk huruf U. Musim kemarau terjadi pada 

bulan Mei – Oktober sedangkan musim penghujan di Kabupaten 

Ngawi mulai bulan November – April. 

 
Gambar 4.2  Rata-Rata Curah Hujan Bulanan. 

 

Gambar 4.3 menunjukkan bahwa outlier tinggi curah hujan 

paling banyak terjadi pada musim kemarau yaitu bulan Juni-

Oktober. Artinya, hujan masih terjadi walaupun sudah memasuki 

musim kemarau.  
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Gambar 4.3  Curah Hujan Bulanan dan Outlier. 
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Meskipun tidak sebanyak pada musim kemarau, pada musim 

penghujan (November – April) juga terjadi tinggi curah hujan 

yang outlier, kecuali bulan Januari dan Maret. Outlier paling 

besar terjadi di bulan November. Hal ini bersesuaian dengan hasil 

deskriptif sebelumnya bahwa variasi terbesar curah hujan di 

Kabupaten Ngawi adalah pada bulan November (Gambar 4.3). 

 

4.3 Pengujian Autokorelasi Moran’s I 

Pengujian autokorelasi Moran’s I berikut dilakukan dengan 

menggunkaan software Geoda. Perbandingan antara nilai indeks 

Moran’s I dan nilai ekspektasinya (E(I)) menunjukkan bahwa 

curah hujan bulan Februari, Juni, Juli, Agustus, September, 

Oktober dan November memiliki nilai autokorelasi positif, maka  

penyebaran tinggi curah hujan pada bulan-bulan itu memiliki pola 

mengelompok. Sedangkan curah hujan bulan Januari, Maret, 

April, Mei dan Desember memiliki nilai autokorelasi negatif, 

maka polanya menyebar (Tabel 4.2). 
 

Tabel 4.2  Nilai I, E(I), Standar Deviasi dan Zhitung 

Bulan I E(I) St.dev Zhitung 

Januari -0,012 -0,042 0,127 0,232 

Februari 0,362 -0,042 0,127 3,173* 

Maret -0,166 -0,042 0,127 -0,984 

April -0,066 -0,042 0,126 -0,191 

Mei -0,106 -0,042 0,134 -0,480 

Juni 0,116 -0,042 0,126 1,256 

Juli 0,180 -0,042 0,125 1,767* 

Agustus 0,127 -0,042 0,125 1,349 

September 0,158 -0,042 0,127 1,568 

Oktober 0,231 -0,042 0,122 2,225* 

November 0,048 -0,042 0,090 0,988 

Desember -0,066 -0,042 0,124 -0,198 

*signifikan pada α=10% 
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 Berdasarkan pengujian autokorelasi spasial yang dilakukan 

dengan indeks Moran’s I pada Tabel 4.2, curah hujan bulan 

Februari, Juli dan Oktober signifikan terdapat autokorelasi spasial 

pada α=10% (Z(1-0.1/2)=1,645). Maka disimpulkan bahwa curah 

hujan bulanan di Kabupaten Ngawi memiliki hubungan spasial 

antar-lokasi stasiun hujannya dan analisis pengelompokan spasial 

dengan metode SKATER dapat dilanjutkan. 

 

4.4 Pengelompokan Stasiun Hujan dengan SKATER 

 Pada analisis ini akan dilakukan pengelompokan stasiun 

hujan dengan metode Spatial ‘K’luster Analysis by Tree Edge 

Removal (SKATER). Pengelompokan berdasarkan 12 variabel 

yang terdiri dari tinggi curah hujan bulanan di masing-masing 

stasiun hujan dari bulan Januari hingga Desember. Gambar peta 

stasiun hujan yang disajikan dalam analisis SKATER ini 

merupakan hasil pemetaan yang sebelumnya telah disajikan 

dalam Gambar 4.1.  

4.4.1 Penentuan Jumlah Kelompok Optimum  

 Penentuan jumlah kelompok yang paling optimum dapat 

dilakukan dengan memeriksa nilai simpangan dalam kelompok 

(Sw), simpangan antar-kelompok (Sb) serta rasio Sw dan Sb pada 

berbagai jumlah kelompok yang ditentukan. Dalam penelitian ini 

ditentukan jumlah kelompok yang akan diperiksa dan 

dibandingkan adalah 2, 3, 4 dan 5 kelompok.  

 
Tabel 4.3  Nilai Sw, Sb dan Ratio pada Berbagai Jumlah Kelompok  

Menurut ZOM 

ZOM 
Jumlah 

Kelompok 
Sw Sb Ratio 

BMKG 2 21,877 0,920 23,758 

SKATER 

2 20,888 5,993 3,485* 

3 172,8962 19,542 8,847 

4 246,230 56,307 4,372 

5 267,171 57,702 4,630 

 *baris yang di blok adalah yang memiliki ratio terrendah 
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 Informasi pada Tabel 4.3 dapat ditampilkan dalam plot Sw, 

Sb dan rasio pada berbagai jumlah kelompok sebagaimana 

disajikan pada Gambar 4.4. 

 

 
Gambar 4.4  Sw, Sb dan Ratio pada Berbagai Jumlah Kelompok. 

 

 Gambar 4.4 menunjukkan bahwa dengan jumlah kelompok  

2, 3, 4 maupun 5, rasio Sw Sb dari ZOM hasil SKATER lebih 

kecil apabila dibandingkan dengan rasio Sw Sb ZOM BMKG. 

Metode SKATER dengan jumlah kelompok sebanyak 2 diketahui 

memiliki rasio Sw Sb yang paling minimum sehingga analisis 

SKATER yang dipilih dalam penelitian ini selanjutnya adalah 

SKATER dengan 2 kelompok.  

 

4.4.2 Analisis SKATER  

 Langkah pertama dalam analisis SKATER adalah 

menentukan Minimum Spanning Tree (MST). Berikut adalah 

langkah-langkah dalam menentukan MST antar-node stasiun 

hujan Kabupaten Ngawi berdasarkan algoritma Prims. 

 

Iterasi 1 
1. Tentukan T1 = (V1, L1) 

 V1 = {v5} 

 L1 = belum diperoleh 
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2. Edge L1 dicari dengan memilih cost minimum dari node 5 

terhadap tetangganya (node 4,1,3,14,23) 

Hitung jarak Euclidian dari d(5,4); d(5,1); d(5,3); d(5,14); 

d(5,23), sehingga diperoleh jarak minimum yaitu antara node 

5 dan 14  d(5,14) = edge la 

3. Didapatkan T2 = (V2, L2) 

 V2 = {v5,v14} 

 L2 =  la 

 

Iterasi 2 

4. Ulangi langkah 2, yaitu mencari edge dengan cost minimum. 

Dari grafik node diketahui bahwa node 5 memiliki 5 tetangga 

sedangkan node 14 memiliki 7 tetangga. 

Hitung jarak Euclidian dari d(5,4); d(5,1); d(5,3); d(5,23); 

d(14,23); d(14,2); d(14,24); d(14,11), d(14,9); d(14,3). 

Diperoleh jarak minimum yaitu antara node 14 dan 11  

d(14,11) = edge lb 

5. Didapatkan T3 = (V3, L3) 

 V3 = {v5,v14,v11} 

 L2 = {la, lb} 

 

Iterasi 3 
6. Ulangi langkah 2. Cari edge dengan cost minimum hingga 

ditemukan edge sebanyak  n-1 (yaitu 25 - 1 = 24 edge) yang 

mencakup seluruh node.   

Akhirnya, akan diperoleh T25 = (V25, L25)  

dan V25={v5,v14,v11,...} = V , dan L2 = {la, Ib,...}. 

 

 Hasil MST dapat dilihat pada Gambar 4.5 berupa garis-garis 

koneksi yang menghubungkan 25 stasiun hujan di Kabupaten 

Ngawi. Penomoran lokasi pada hasil MST ini tidak bersesuaian 

dengan nomor ID stasiun sehingga harus berhati-hati dalam 

menyesuaikan nomor lokasinya dengan nama stasiun pada Tabel 

3.1.  
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 Koneksi yang pertama terbentuk adalah dari lokasi nomor 5 

dan 14 yaitu stasiun Jururejo/Mardiasri dan Tepas/Sudhono. 

Selanjutnya, koneksi ke-dua adalah lokasi nomor 14 dan 11 yaitu 

stasiun Tepas/Sudhono dan Keras Kulon. Hingga koneksi terakhir 

adalah lokasi nomor 13 dan 19 yaitu stasiun Gentong/Bekoh dan 

Kedung Galar. 

 
Gambar 4.5  MST Stasiun Hujan Kabupaten Ngawi. 

 

Langkah kedua dalam analisis SKATER adalah melakukan 

partisi MST. Awalnya, seluruh stasiun masuk dalam sebuah 

pohon yang sama yaitu MST yang telah terbentuk sebelumnya. 

Selanjutnya akan ada proses penghapusan edge dari MST asli. 

Pada setiap iterasi, pohon dibagi menjadi dua dengan memotong 

sebuah edge yang membagi wilayah menjadi paling homogen, 

yaitu dengan jumlah kuadrat deviasi dalam kelompoknya paling 

minimum. Hasil partisi MST stasiun hujan Kabupaten Ngawi 

menghasilkan 2 kelompok seperti yang dapat dilihat pada Gambar 

4.6.  

Berdasarkan hasil partisi tersebut dapat diketahui bahwa 25 

stasiun hujan seluruhnya masuk dalam kelompok yang terdiri dari 
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2 kelompok. Letak dari stasiun-stasiun hujan saling berdekatan 

dengan anggota sekelompoknya. Kelompok I terdiri dari 7 stasiun 

hujan yang letaknya di bagian timur dari Kabupaten Ngawi, 

sedangkan kelompok II terdiri dari 18 stasiun hujan yang letaknya 

di bagian barat. 

 
Gambar 4.6  Partisi MST Stasiun Hujan Kabupaten Ngawi. 

 Gambar 4.7 menampilkan plot poligon spasial sesuai hasil 

pengelompokan stasiun hujan di Kabupaten Ngawi dengan 

menggunakan metode SKATER. Lokasi yang berwarna merah 

adalah daerah kelompok I sedangkan yang berwarna kuning 

adalah kelompok II. 

 
Gambar 4.7   Poligon Stasiun Hujan Kabupaten Ngawi dengan 

  SKATER. 
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 Kelompok I mempunyai 7 anggota kelompok yaitu stasiun 

hujan dengan ID nomor 5, 7, 8, 9, 10, 11, 13. Secara berurutan, 

nama anggota kelompok I adalah stasiun hujan Keras Kulon, 

Tepas/Pg Sudhono, Budug, Legundi/ Karangjati, Kedungbendo, 

Cangaan/ Padas, Jururejo/ Mardiasri. Sedangkan untuk kelompok 

II terdiri dari 18 stasiun hujan selain anggota kelompok I. Rata-

rata serta standar deviasi tinggi curah hujan berdasarkan bulan 

untuk masing-masing kelompok dapat dilihat pada Tabel 4.4 

sebagai berikut. 

 
Tabel 4.4  Rata-Rata dan Standar Deviasi  Curah Hujan Berdasarkan  

  Hasil ZOM SKATER 

Bulan 

Rata-Rata  Standar Deviasi 

Kelompok Kelompok 

I II I II 

Januari 214,360 279,973 72,802 64,480 

Februari 237,423 267,838 93,509 44,826 

Maret 236,863 272,558 74,489 49,193 

April 189,466 207,374 64,925 43,803 

Mei 91,483 99,626 30,888 21,686 

Juni 33,864 57,502 14,103 11,811 

Juli 23,490 25,971 7,850 9,404 

Agustus 7,650 13,341 4,832 6,358 

September 15,131 23,492 9,232 7,549 

Oktober 77,694 105,333 36,770 28,577 

November 190,329 221,756 68,158 90,127 

Desember 200,136 246,039 70,929 36,654 

 

 Rata-rata curah hujan bulanan pada stasiun kelompok II lebih 

tinggi daripada kelompok I. Standar deviasi curah hujan pada 

stasiun kelompok I  lebih tinggi daripada kelompok II, kecuali 
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pada bulan Agustus dan November (Tabel 4.4). Hal ini terjadi 

dapat disebabkan oleh adanya outlier pada kedua bulan tersebut.  

 

4.4.3 Pengujian Perbedaan Rata-Rata Kelompok Hasil 

SKATER 

 Uji t berpasangan dilakukan untuk mengetahui ada atau 

tidaknya perbedaan rata-rata antara dua kelompok yang 

berpasangan dari ZOM yang terbentuk. Sebelum dilakukan uji t 

berpasangan perlu dilakukan uji normalitas dengan Saphiro Wilk 

dengan hipotesis: 

 H0 :  Kedua kelompok berdistribusi normal  

 H1  :  Kedua kelompok tidak berdistribusi normal 

 Hasil pengujian normalitas menyimpulkan bahwa kedua 

kelompok berdistribusi normal dengan P-value (0,422) > α (0,05). 

Maka selanjutnya dapat dilanjutkan dengan uji t berpasangan 

dengan hipotesis sebagai berikut. 

H0 :  Tidak ada perbedaan rata-rata curah hujan pada  

kelompok I dan kelompok II 

H1 :  Ada perbedaan rata-rata curah hujan pada kelompok I 

dan kelompok II 

 Hasil uji t berpasangan menghasilkan P-value (0,001) < α 

(0,05) atau |-4,723| > t(0.05/2); 11) (2,201) sehingga tolak H0 dan 

dapat disimpulkan bahwa terdapat perbedaan antara kelompok I 

dan kelompok II. 

 

4.5 Pemilihan ZOM Terbaik 

Melalui analisis SKATER jumlah kelompok optimum yang 

dihasilkan adalah dua kelompok tetapi alokasi anggota pada 

setiap kelompoknya berbeda dari ZOM BMKG. Hasil 

pengelompokan SKATER kelompok I merupakan ZOM 2, 

kelompok II merupakan ZOM 1.  Perbandingan anggota ZOM 

BMKG dengan ZOM hasil metode SKATER dapat dilihat pada 

Gambar 4.8 berikut. 
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Gambar 4.8  Perbandingan Anggota ZOM 1 dan ZOM 2 antara ZOM  

  BMKG (a) dan ZOM SKATER (b). 
 

 Gambar 4.8 menunjukkan bahwa setelah dilakukan  

pengelompokan SKATER  keanggotaan ZOM 1 menjadi meluas 

hingga meliputi 18 lokasi pos hujan jika dibandingkan dengan 

ZOM 1 dari BMKG. Hal tersebut menunjukkan bahwa jumlah 

ZOM yang dihasilkan dari metode SKATER memang sama 

dengan ZOM BMKG yaitu sejumlah dua kelompok tetapi 

anggota-anggota di dalam ZOM 1 dan ZOM 2 adalah berbeda.  

 Selanjutnya, perbandingan antara ZOM BMKG dan ZOM 

hasil SKATER dapat dilihat berdasarkan simpangan dalam 

 

ZOM 1 ZOM 2 

ZOM 1 

ZOM 2 

a) 

b) 
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kelompok (Sw) dan simpangan antar-kelompok (Sb). Selain itu, 

perbandingannya dapat ditinjau berdasarkan rasio antara Sw dan 

Sb pada kedua ZOM.  

 
Tabel 4.5 Nilai Sw dan Sb antara ZOM BMKG dan ZOM SKATER 

ZOM Sw Sb Rasio 

BMKG 21,878 0,921 23,759 

SKATER  20,888 5,993 3,485 

 

Nilai simpangan dalam kelompok (Sw) ZOM hasil SKATER 

lebih kecil dibandingkan dengan Sw ZOM BMKG, sedangkan 

simpangan antar-kelompok (Sb) ZOM hasil SKATER lebih besar 

daripada Sb ZOM BMKG. Rasio antara simpangan dalam 

kelompok dan simpangan antar-kelompok ZOM hasil SKATER 

lebih kecil daripada rasio ZOM BMKG (Tabel 4.5). Hal ini 

berarti bahwa ZOM hasil SKATER lebih homogen daripada 

ZOM BMKG, sehingga dapat disimpulkan bahwa kinerja ZOM 

hasil SKATER lebih baik jika dibandingkan dengan ZOM 

BMKG. 
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(Halaman ini sengaja dikosongkan) 
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BAB V 

KESIMPULAN DAN SARAN 
 

5.1 Kesimpulan 

 Berdasarkan hasil analisis data curah hujan bulanan di 

Kabupaten Ngawi, diperoleh kesimpulan sebagai berikut. 

1. Hasil pemetaan Kabupaten Ngawi berdasarkan lokasi stasiun 

hujannya dapat dilihat pada Gambar 4.1. 

2. Hasil analisis deskriptif dan uji autokorelasi antar-lokasi 

stasiun hujan : 

a. Musim kemarau terjadi pada bulan Mei – Oktober 

sedangkan musim penghujan di Kabupaten Ngawi mulai 

bulan November – April. Puncak musim kemarau di 

Kabupaten Ngawi terjadi pada bulan Agustus, sedangkan 

puncak musim penghujannya adalah pada bulan Maret. 

b. Berdasarkan uji autokorelasi dengan indeks Moran’s I, 

curah hujan bulan Februari, Juli dan Oktober signifikan 

terdapat autokorelasi spasial pada α=10%. Maka 

disimpulkan bahwa curah hujan bulanan di Kabupaten 

Ngawi memiliki hubungan spasial antar-lokasi stasiun 

hujannya. 

3. Hasil analisis SKATER menghasilkan 2 kelompok. 

Kelompok I mempunyai 7 stasiun hujan dan kelompok II 

terdiri dari 18 stasiun hujan. 

4. Hasil perbandingan antara ZOM BMKG dan ZOM SKATER: 

a. Rata-rata curah hujan bulanan pada stasiun kelompok II 

lebih tinggi daripada kelompok I. Standar deviasi curah 

hujan pada stasiun kelompok I  lebih tinggi daripada 

kelompok II, kecuali pada bulan Agustus dan November. 

b. Berdasarkan uji t berpasangan, terdapat perbedaan antara 

kedua kelompok hasil SKATER. 

c. Rasio antara simpangan dalam kelompok (Sw) dan 

simpangan antar-kelompok (Sb) ZOM hasil SKATER 

mempunyai nilai rasio yang lebih kecil daripada rasio 

ZOM BMKG. Hal ini berarti bahwa ZOM hasil SKATER 
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lebih homogen daripada ZOM BMKG, sehingga dapat 

disimpulkan bahwa kinerja ZOM hasil SKATER lebih 

baik jika dibandingkan dengan ZOM BMKG. 

 

5.2 Saran 

 Penelitian ini melibatkan pemetaan lokasi stasiun hujan yang 

awalnya berupa titik lalu ditranformasi menjadi area, sehingga 

peneliti perlu mempelajari lebih lanjut mengenai pemetaan 

dengan berbagai metode/pendekatan.  Selain itu, penentuan 

kelompok pada penelitian ini belum dikoreksi lebih lanjut dengan 

menggunakan peta kontur curah hujan maupun elevasi. Oleh 

karena itu saran untuk penelitian lebih lanjut dapat menambahkan 

pemeriksaan hasil pengelompokan dengan peta kontur agar 

memperoleh hasil yang lebih akurat. Kepada BMKG disarankan 

untuk mempertimbangkan efek spasial dalam membentuk zona 

musim agar diperoleh hasil pengelompokan yang lebih homogen. 
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LAMPIRAN 

 
Lampiran 1. Surat Pernyataan Pengambilan Data 
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Lampiran 2. Data rata-rata tinggi curah hujan bulanan di 

Kabupaten Ngawi tahun 1990-2015 menurut masing-masing 

stasiun hujan. 

N

o 
Nama Stasiun 

Tinggi Curah Hujan (mm) 

Jan Feb ... ... ... Des 

1 Babadan 194,62 162,04 . . . 164,08 

2 Banyubiru/Tretes 321,38 270,65 . . . 213,19 

3 Begal 199,00 200,92 . . . 207,46 

4 Budug 146,65 173,19 . . . 156,12 

5 Cangaan/Padas 186,19 194,62 . . . 172,62 

6 Dawung/Jogorogo 404,00 338,62 . . . 334,38 

7 

Gemarang/Sokonga

direjo 244,23 267,27 . . . 252,73 

8 Gentong/Bekoh 294,88 268,46 . . . 255,50 

9 Guyung 321,00 301,65 . . . 268,12 

10 Jururejo/Mardiasri 274,85 281,15 . . . 267,96 

. . . . . . . . 

. . . . . . . . 

. . . . . . . . 

21 Ngancar/Papungan 216,69 272,96 . . . 244,31 

22 Ngrambe 341,73 279,79 . . . 263,12 

23 Paron 251,58 287,08 . . . 263,92 

24 Tepas/Pg Sudhono 230,31 240,04 . . . 207,35 

25 

Widodaren/Wali 

Kukun 325,54 285,31 . . . 254,46 
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Lampiran 3. Langkah-Langkah Pembuatan Peta Stasiun Hujan 

dengan Thiessen Polygons 

 

1. Buka software QGIS, berikut ini tampilannya. 

 
 

2. Buka peta shp yang akan digunakan yaitu peta Kabupaten 

Ngawi dan peta titik lokasi stasiun hujan. 

Klik menu Layer > Tambah Lapisan > Tambahkan layer 

vektor > pilih theme-ngawi.shp 
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Dengan cara yang sama, buka shp titik hujan ngawi.shp 

 

Hasil dari 2 peta shp yang dibuka di QGIS adalah seperti berikut 

ini. Perhatikan bahwa pada urutan layer (window sebelah kiri), 

titik hujan ngawi.shp berada di atas theme-ngawi.shp 

 
 

3. Membuat Voronoi Polygons 

Klik menu Vector > Geometry Tools > Voronoi Polygons 
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Muncul window Poligon Voronoi. 

 Masukan layer vektor titik : titik hujan ngawi 

 Klik OK 

 
 

Pilih tempat penyimpanan  



54 

 

 

Hasil vorinoi titik hujan: 
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4. Cara  Clipping 

Geser layer theme-ngawi.shp ke paling atas, maka: 

 

 
 

Klik menu Vector > Geoprocessing tools > Clip 
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Pada window Clip, isilah : 

 Masukan layer vektor  titikhujan 

 Layer pemotong  theme ngawi 

 OK 

 Simpan hasil clip 

 OK 

 
 

Hasil clip : 
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5. Tata layer dengan urutan dari atas ke bawah: 

Titik hujan ngawi—hasil clip—theme ngawi 

 
 

6. Untuk mengedit simbol/warna titik-titik hujan, dengan klik kanan 

layer titik-titik hujan > Properties 

 
 

 

 

 

 

 

 



58 

 

7. Untuk menambah label, menu Layer > Pelabelan 

 
 

8. Klik aktifkan tanda silang ―label layer ini dengan: .....(sesuai 

keinginan, misal: ID)  sebelah atas kiri 
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Hasil akhir Clip :  

 
 

9. Untuk menyimpan gambar: 

Menu Project > Save image as... 
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Lampiran 4. Syntax SKATER 

 

###skater1 [17mei 2017] 

#edited by : Partini Ningsih 

 

library(spdep) 

library(lattice) 

library(maptools) 

library(e1071) 

library(classInt) 

library(RColorBrewer) 

 

peta <- readShapePoly("E:/ngawiposhu.shp") 

plot(peta) 

win.graph() 

 

data <-read.table("E:/data_curah hujan.txt", sep="", 

header=TRUE) 

sapply(data, class) 

 

peta$X1=data$jan 

peta$X2=data$feb 

peta$X3=data$mar 

peta$X4=data$apr 

peta$X5=data$mei 

peta$X6=data$jun 

peta$X7=data$jul 

peta$X8=data$agt 

peta$X9=data$sep 

peta$X10=data$okt 

peta$X11=data$nov 

peta$X12=data$des 

 

datapeta <- data.frame(peta) 

data1=datapeta[,5:16] 
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#neighborhood list 

bh.nb <- poly2nb(peta) 

 

#calculating costs 

lcosts <- nbcosts(bh.nb, data1) 

 

#making list w 

nb.w <- nb2listw(bh.nb, lcosts, style="B") 

 

#find mst 

mst.bh <- mstree(nb.w,5) 

 

#the mstree plot 

par(mar=c(0,0,0,0)) 

plot(mst.bh, coordinates(peta), col=3,cex.lab=.7, 

cex.circles=0.035, fg="blue") 

plot(peta, border=gray(.5), add=TRUE) 

win.graph() 

 

res1 <- skater(mst.bh[,1:2], data1, ncuts=1, method="euclidean") 

 

table(res1$groups) 

par(mar=c(0,0,0,0)) 

plot(res1, coordinates(peta), cex.circles=0.035, cex.lab=.7) 

win.graph() 

plot(peta, col=heat.colors(5)[res1$groups]) 

d1=data.frame(group=res1$group, data1) 

d1 
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Lampiran 5. Output Uji Normalitas dan Uji t – Paired 

 

 

 

 

 

 

 
Paired Samples Statistics 

 Mean N Std. 
Deviation 

Std. Error 
Mean 

Pair 
1 

rata2_grup1 126,49075 12 92,928850 26,826248 

rata2_grup2 151,73358 12 107,271564 30,966633 

 
Paired Samples Correlations 

 N Correlation Sig. 

Pair 
1 

rata2_grup1 & 
rata2_grup2 

12 ,993 ,000 

 
Paired Samples Test 

 Paired Differences t d
f 

Sig. 
(2-
tail
ed) 

Mean Std. 
Deviati

on 

Std. 
Error 
Mean 

95% 
Confidence 

Interval of the 
Difference 

Lower Upper 

P
air 
1 

rata2_g
rup1 - 
rata2_g
rup2 

-
25,242

833 

18,514
684 

5,344
729 

-
37,006

502 

-
13,479

165 

-
4,7
23 

1
1 

,00
1 

 

 
 
 

Tests of Normality 

 Kolmogorov-Smirnov
a
 Shapiro-Wilk 

Statistic df Sig. Statistic df Sig. 

d ,152 12 ,200
*
 ,934 12 ,422 

*. This is a lower bound of the true significance. 
a. Lilliefors Significance Correction 
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